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Submission 
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1975 

Texas 
Legislature 
established 
rulemaking 
publication 
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Register 

publication 
began, 
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diskettes  
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electronic 
bulletin 
board 
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Available on 
the SOS 
Website, 
January 
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Submission 
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Printing of 
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publication 
outsourced, 
September 

2014 

New cloud 
system is 

established 
for 

submission 
to the Texas 

Register  
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 Journal of state agency rulemaking for Texas 
◦ Publishes proposed, adopted, withdrawn and emergency rule actions 
◦ Publishes rule review, governor’s appointments, attorney general opinions 

and miscellaneous documents 
◦ After adoption, rulemaking actions are codified into the Texas 

Administrative Code (TAC) 
◦ TAC is updated regularly; 
 TAC online (and available for download) are the rules currently in effect 

 
 Posted every Friday; 
◦ Available no later than 5:00 p.m. 
◦ Deadlines depend on the document submitted 
 Publication is generally two weeks behind deadline 

◦ Current issue and up to 12 months of previous issues are posted on the 
SOS website 
 Issues older than 12 months are available in the archive link through the 

University of North Texas 



Access 
Navigate 
Downloading 
Account 

Texas Register Liaison Training Updated: January 2015 6 



Access 
Navigate 
Downloading 
Account 

Texas Register Liaison Training Updated: January 2015 7 



Accessing the Liaison Center 

Texas Register Liaison Training 

www.sos.texas.gov  State Rules and Open 
Meetings  Liaison Login 
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http://www.sos.texas.gov/


Accessing the Liaison Center 
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Liaison Center 
available links 

populate based on 
the documents the 
liaison submits to 
the Texas Register 
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When a liaison logs out 
of the Liaison Center, 

“you have been 
successfully 

deauthenticated,” will 
come up on the screen. 

This does not mean the 
liaison is removed from 

the liaison database. 
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Where liaisons may 
find open meeting 
postings as seen by 
the public 
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Liaison Center 
Home Screen 

Select “TAC 
Document Request” 
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Select “Agency” for 
the appropriate 
Title Number and 
Title Name 
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Select “Chapters” 
of the appropriate 
Agency Name and 
Part Number 
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Downloading the 
entire chapter? 

Select “Chapter 
Request” 

Downloading the 
specific subchapters? 

OR 

Updated: January 2015 24 

Select “Subchapters” 
of the appropriate 
Chapter Number 
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“Chapter Request” 
follows the same format 

Select desired format 
for download 

Enter a valid email 
address in the email 
field 

Select “Submit 
Document Request” 

Updated: January 2015 25 



Texas Register Liaison Training 

More 
Subchapters/ 
Chapters to 
download? 
 
Select “Request 
New Document” 

Finished?  
 
Select “Back” to 
return to the 
Liaison Center 
Home Screen. 

You will receive an email when your document is prepared 
for download. 

Updated: January 2015 26 



Texas Register Liaison Training 

Liaison Center 
Home Screen 

Select “Document 
Request Queue” 

Updated: January 2015 27 



Texas Register Liaison Training 

Chose 
applicable 

option 

Edit as needed 
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Updating Contact Information 
Changing Password 
Administrative Liaison 

• Adding New Liaison 
• Removing Liaison 
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 Three access levels 

1. Open Meetings 
 Ability to post and cancel open meetings 

2. Open Meetings and Register 
 Ability to post and cancel open meetings 
 Ability to post miscellaneous documents to the Texas Register 

 If appropriate, ability to post rulemaking documents to the Texas 
Register (for state-wide rulemaking agencies) 

 
3. Open Meetings, Register and Administrative 

 Ability to post and cancel open meetings 
 Ability to post miscellaneous (and rulemaking) documents to the 

Texas Register 
 Ability to add and remove liaisons within their agency 

 Limited number of available administrative liaisons  



Updating Contact Information 
Changing Password 
Administrative Liaison 

• Adding New Liaison 
• Removing Liaison 
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Updating Liaison Contact Information 

Updating Liaison Password 
If you need further assistance, please contact us. 
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 What can I change? 
◦ Job title; E-mail; Phone 

Liaison Center
Home Menu 

 

Select “Liaison 
Account 

Information” 
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Change 
applicable 

information 
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Select  
“Update Profile” 
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Successful 

“Rows updated: 1” 
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Liaison Center 
Home Menu 

Select “Liaison 
Password 
Update” 
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Enter a new 
password 

Select  
“Update” 
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Successful 

“Success: Password 
update complete” 
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Updating Contact Information 
Changing Password 
Administrative Liaison 

• Adding New Liaison 
• Removing Liaison 

Texas Register Liaison Training Updated: January 2015 40 



Ad
m

in
is

tr
at

iv
e 

Li
ai

so
n 

Ad
di

ng
 a

 N
ew

 L
ia

is
on

 

Texas Register Liaison Training 

If you need further assistance, please contact us. 
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Adding a New Liaison 
Liaison Center 
Home Menu 

Select “Liaison 
Administration” 

“Liaison 
Administration” 
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Select  
“Add Liaison” 
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Enter the 
applicable 
information 

Select  
“Submit Form” 

Error Message? 

Updated: January 2015 43 

Call or Email  
Texas Register staff: 

512-463-5561 
register@sos.texas.gov 
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If you need further assistance, please contact us. 
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Removing Liaison Accounts 
Liaison Center 
Home Menu 

Select “Liaison 
Administration” 

“Liaison 
Administration” 

Select the 
Liaison to 
Remove 
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Removing Liaison Accounts 

Updated: January 2015 46 

Check 
“Purge Request: Yes”  

Select  
“Update” This sends the Texas 

Register staff a request to 
remove the liaison. 

The Liaison will no 
longer appear in the 
list of active liaisons. 
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For further information, find their 
publication of the Open Meetings Act 
Handbook under the “Open Government” 
section on the Attorney General website 

 

Office of the Attorney General 
oversees the guidelines 

regarding Open Meetings 
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 Open Meetings Act – §551.041 
◦ “A governmental body shall give written notice of 

the date, hour, place, and subject of each meeting 
held by the governmental body” 

 
Specific questions regarding Open Meetings: 
Contact the Office of the Attorney General 

512.478.6736 
The following slides 

are *OUR* 
interpretation of the 
rules regarding the 
Open Meetings Act. 
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Regional Agencies  

 Jurisdiction of 
four or more 
counties 

State Agencies 

 Statewide 
jurisdiction 
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Sun Mon Tues Wed Thurs Fri Sat 

1 2 3 4 5 6 7 

8 9 10 11 12 

15  6 17 18 

22 23 24 25 26 

29 30 31 

72 hour Posting Requirement – 
Regional Agencies 

§551.043: 
“The notice of a meeting of 
a governmental body must 
be posted in a place readily 
accessible to the general 
public at all times for at 
least 72 hours before the 
scheduled time of the 
meeting, except as 
provided by Sections 
551.044-551.046.” 
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19 2pm 
Open 
Meeting 

24 48 72 

1Post by 
2pm 

Specific questions regarding Open Meetings: 
Contact the Office of the Attorney General 

512.478.6736 
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Sun Mon Tues Wed Thurs Fri Sat 

1 2 3 4 5 6 7 

8 9 10 12 13 14 

15 16 17 18 D 20 21 

22 23 24 25 26 

29 30 31 

7 Day Posting Requirement – 
State Agencies 

Updated: January 2015 53 

§551.044: 
“The secretary of state 
must post notice on the 
Internet of a meeting of a 
state board, commission, 
department, or officer 
having statewide 
jurisdiction for at least 
seven days before the day 
of the meeting.” 

ay of 19 
Meeting 

1 2 3 4 

5 6 7 

Day of 11 
Posting 

Specific questions regarding Open Meetings: 
Contact the Office of the Attorney General 

512.478.6736 



Open Meetings 
Requirement Exceptions 

 §551.045 Exception to General Rule: Notice of 
Emergency Meeting or Emergency Addition to Agenda. 

 
◦ (a) In an emergency or when there is an urgent public necessity, 

the notice of a meeting or the supplemental notice of a subject 
added as an item to the agenda for a meeting for which notice has 
been posted in accordance with this subchapter is sufficient if it is 
posted for at least two hours before the meeting is convened. 

 
◦ (b) An emergency or an urgent public necessity exists only if 

immediate action is required of a governmental body because of: 
 (1) an imminent threat to public health and safety; or 
 (2) a reasonably unforeseeable situation. 
 

◦ (c) The governmental body shall clearly identify the emergency or 
urgent public necessity in the notice or supplemental notice under this 
section. 

Texas Register Liaison Training 

**Must be posted “two (2) hours before 
the meeting is convened”** 
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 The Secretary of State is not responsible for the 
information or content that is contained in open 

meeting notices. Nor does the SOS make any 
representations as to sufficiency or accuracy of 
the posted information. The postings contained 

in the Texas Register are submitted 
electronically by parties outside the control of 
the SOS and any questions about a particular 

posting should be directed to that entity. 
Contact information is included in each posted 

document. 
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Liaison Center 
Home Screen 

Select “Open 
Meeting Submission” 

Updated: January 2015 59 
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Enter the 
applicable 
information 

Agendas can be copied directly from Word 
up to 10 pages 
  Do not use Table formatting  

Leave blank unless meeting qualifies under 
§551.045 of the Open Meetings Act 

Physical address with room number 

Updated: January 2015 60 

When complete, 
select “Submit Form” 
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Unsuccessful 
Error Message 

Examples 

Contact the Texas Register staff if you need 
additional support: 512.463.5561 

Updated: January 2015 61 
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Successful 
Receive an 

Acknowledgment of 
Receipt via email 

If you are not receiving an emailed acknowledgment of receipt, please verify your email address 
on the liaison account information; then double check your email permissions as it might be 

going directly to junk mail folders. If you continue to have concerns – contact us. 
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Corrections must be made outside of the time requirements. 
 

If corrections/revisions are made after the posting deadlines, 
the meeting could be considered invalid. 

Regional Agencies  
72 hours prior to meeting time 

State Agencies 
7 full days prior to meeting date 

Updated: January 2015 64 

If you need further assistance, please contact us. 
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Liaison Center 
Home Screen 

Select “Open 
Meeting Submission” 
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Enter the 
applicable 
information 
with the 
necessary 
corrections 
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Original Summary 

Reference the 
Original Meeting 
TRD Number from 
the summary or 
Acknowledgement 
of Receipt 

Updated: January 2015 67 

When complete, 
select “Submit Form” 



Texas Register Liaison Training Updated: January 2015 68 

Successful The TRD listed in 
the summary 
becomes the new 
“Accepted” status 
meeting 

The Original 
Meeting TRD 
Number status is 
altered from 
“Accepted” to 
“Revised/ 
Rescheduled” 
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Canceling Open Meetings 

Deleting Open Meetings 
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Liaison Center 
Home Screen 

Select “Open Meeting 
Cancellation” 
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Only meetings 
with an 
“Accepted” 
status will be 
available to 
Cancel 
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Select the TRD 
of the meeting 
to cancel 
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Alter the 
Status from 
“Accepted” to 
“Canceled” 
using the drop 
down menu 
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Select “Cancel 
This Meeting” 
to finalize 
cancellation 
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You will not 
receive a 
confirmation of 
cancellation. If 
you wish to 
confirm: 

Return to the 
Liaison Center 
Home Screen 

Select “Open 
Meeting 
Cancellation” 
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Only meetings 
with an 
“Accepted” 
status will be 
available to 
Cancel 

If the TRD 
canceled is 
not listed, it 
has been 
altered 
publicly as a 
“Canceled” 
meeting 
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If you attempt 
to Delete an 
Open Meeting 
through the 
“Open Meeting 
Cancellation” 
function: 

Updated: January 2015 77 
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register@sos.texas.gov 
512.463.5561 

Multiple error 
messages will 
be visible, 
prompting 
the liaison to 
contact the 
Secretary of 
State 

Updated: January 2015 78 
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Only way to delete 
open meetings 

from public record 
is to  

contact Texas 
Register Staff 
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register@sos.texas.gov 
512.463.5561 

mailto:register@sos.texas.gov
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Submission forms and 
corresponding files need 
to be submitted and 
received by  
 
 Wednesday at noon We will notify you of 

holiday exceptions. 
 
Still unsure? Wishing to 
plan? 

Publication schedule 
can be found on the 
Liaison Center Home 

screen 
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In Addition 
Documents 

 Insert a section symbol, § 
 

 Emphasize text with bold, italics or ALL CAPS 
◦ Continue the emphasis through the punctuation 

immediately following the emphasized text 
 

 Use any justification, font or line spacing 

Please view “Formatting the Word document” to 
properly structure the submission document. 

Updated: January 2015 84 
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In Addition 
Documents 

 Utilize any automatic Word formatting 
 

 Show emphasis using underline or strikethrough text 
 

 Utilize hyperlinks within the file 
 

 Utilize *n to create multiple documents within one file 
 

 Include a space between a section symbol and rule 
number 
◦ Correct: §74.1, Incorrect: § 74.1 

Please view “Formatting the Word document” to 
properly structure the submission document. 
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In Addition 
Documents 

 Naming the file: 
◦ Under 15 characters 
◦ Numbers and words only 
 No special characters (periods, spaces, number symbols, dashes, etc.) 
 Examples: SEC101, TxRegSub15, AGOpinions, etc 

 
 Referencing graphics: 
◦ Cite “figure” at the appropriate location within the file 
◦ Upload the graphics file as an additional document after the main 

Word document within the same submission form 
 

 Submitting the file 
◦ Upload at the time of submission 
◦ You are not able to upload the file at any other time 

Must be saved as a Word document: .doc or .docx 
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Documents submitted should be created 
using the following format settings. 

This allows the Texas Register staff to process the document. 
If the document is not created using the format settings, the 

document will not go through the Texas Register software 
appropriately.   

• Setting the style format 
• Removing numbered and bulleted lists 
• Inserting bullets 
• Inserting section symbols 
• Utilizing paragraph viewer 
• Saving the file 

*The following instructions for Word are based on Word 
2010. If you have another version of Word, please seek 

assistance through Word help or your IT department.  
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From the “Home” tab in Word,  
• Under “Styles,”  
• Select “¶ Normal” 

This removes Headings, unusual 
spacing and additional 

formatting Texas Register 
software will not be able to 

read. 
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Word automatically creates numbered and bulleted lists 
based on previous formatting preferences. Texas Register 
software does not process these as numbers or bullets, but 
as images. It is necessary to manually input these in order for 
the Texas Register staff to process the document effectively.  

From the “File” tab 
in Word,  
• Select “Options” 

In the pop-up 
window,  
• Select 

“Proofing,”  
• Then select 

“AutoCorrect 
Options…” 



Updated: January 2015 Texas Register Liaison Training 90 

In the AutoCorrect pop-up 
window, 
 
Under the “AutoFormat” 
tab, 
 
Under “Apply” 
De-select the following 
options: 
• “Built-in Heading 

styles,”  
• “List styles,”  
• “Automatic bulleted 

lists”  
• “Other paragraph styles” 
 
Under “Replace” 
De-select  
• “‘Straight quotes’ with 

‘smart quotes’” 
 
Select “OK” in the 
AutoCorrect pop-up 
window 
 
Then select the 
“AutoFormat As You Type” 
tab 
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Under the “AutoFormat As 
You Type” tab, 
 
Under “Replace as you 
type,” de-select the 
following: 
• “‘Straight quotes’ with 

‘smart quotes’” 
 
Under “Apply as you type,” 
de-select the following 
options: 
• “Automatic bulleted 

lists”,  
• “Automatic numbered 

lists”, 
• “Border lines”,  
• “Tables” and 
• “Built-in Heading 

styles” 
 
Select “OK” in the 
AutoCorrect pop-up 
window. 
 
Select “OK” in the Word 
Options pop-up window. 
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Bulleted lists can still be used, when each bulleted is inserted 
using the symbol function within Word. 

From the “Insert” tab in Word,  
• Select “Symbol,” 
• Under “Subset:,” 
• Select “Latin-1 Supplement,” 
• Select “·”  

• Character code “00B7” 



Updated: January 2015 Texas Register Liaison Training 93 

Section symbols should be used instead of the word “Section” 
when appropriate; example 1 TAC §91.75 

From the “Insert” tab in Word,  
• Select “Symbol,” 
• Under “Subset:,” 
• Select “Latin-1 Supplement,” 
• Select “§”  

• Character code “00A7” 
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The paragraph function in Word allows users to view any 
additional or hidden formatting within the document  

From the “Home” tab in Word,  
• Under “Paragraph” 
• Select “¶” 
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Saving the file as a Word document, if not saved in the 
correct format, the document will not be processed by the 
software. 

From the “File” tab in Word 
• Select “Save As” 
• Type the new file name 
• Under “Save as type:” select: 

• “Word 97-2003 Document (*.doc) OR 
• “Word Document (*.docx) 

Must be saved as a “Word Document (*.docx)” or “Word 97-2003 
Document (*.doc)”  
Do not type “.doc” or “.docx” in the file name – Word will add the .doc or .docx 

extension once the type of document is selected and saved  
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Submitting Miscellaneous  
Submitting Executive 
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Miscellaneous Documents 
include information for the 
general public published in 
the “In Addition” section of 

the Texas Register.  

Updated: January 2015 97 

 Public Notice 
 Request for Proposals 
 Notice of Contract 
 Notice of Contract Amendment 

 
 For a comprehensive listing,  

Texas Government Code 

http://www.statutes.legis.state.tx.us/Docs/GV/htm/GV.2001.htm


You may submit the file 
using any font, text size 

and justification; the 
Texas Register  staff will 

alter the style to fit the 
standardized publication. 
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Texas Department of Transportation (Agency Name) 

Public Notice – Aviation (Document Title) 

Pursuant to Transportation Code; §21.111, and 43 Texas Administrative Code §30.209, the Texas 
Department of Transportation conducts public hearings to receive comments from interested 
parties concerning proposed approval of various aviation projects. 

For information regarding actions and times for aviation public hearings, please go to the following 
website: 

http://www.dot.state.tx.us 

Click on Aviation, click on Aviation Public Hearing. Or, contact Karon Wiedemann, Aviation Division, 
150 East Riverside, Austin, Texas 78704, (512) 416-4520 or 1-800-68 PILOT. 
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Uploading Associated Documents 

Texas Register Liaison Training 

**Must upload documents with the submission 
form. You are not able to return and upload files 

at another time.** 
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Liaison Center 
Home Screen 

Select “Miscellaneous 
Document Submission” 
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Enter the 
applicable 
information 

Title as Published in the Texas Register 
Name of the 

file to be 
uploaded on 

the next 
screen 

Miscfile2.doc 

Additional Information. 
If graphics are included, identify the graphics 
file name here:  
MiscfileGraphic.pdf 

Select “Submit Form” 
when prepared 
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Review the summary 

If the summary is 
accurate, select “Continue 
to File Upload” to upload 
the files associated with 

the submission 

Updated: January 2015 103 

If there are any ERRORS, 
select “Upload Another 
Submission Form” and 

send an email  to 
register@sos.texas.gov 
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Select “Browse” Select the 
identified 
associated file 
from your 
available 
computer files 

Select “Upload Document” 

Repeat the 
process as 
needed to 
attach the 

appropriate 
documents 

Select 
“Submission 
Complete” to 

finalize 
submission 

**Must upload documents with the submission 
form. You are not able to return and upload at a 

later time.** 
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General Overview 
Formatting 
Submitting Miscellaneous 
Submitting Executive 
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Texas Register Liaison Training 

Executive Submissions 
follow the same formatting 
guidelines as Miscellaneous 

Documents. For additional 
information on posting 
requirements, view the 

Texas Government Code. 
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 Filed by Executive State Agencies 
 Governor Appointees 
 Texas Ethics Opinions 
 Executive Orders and Proclamations 

Deadline: 
Wednesday at Noon 
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Uploading Associated Documents 

Texas Register Liaison Training 

**Must upload documents with the submission 
form. You are not able to return and upload files 

at another time.** 
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Liaison Center 
Home Screen 

Select “Executive 
Submission” 
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Texas Register Liaison Training 

Enter the 
applicable 
information 

Title as Published in the Texas Register Name of the 
file to be 

uploaded on 
the next 
screen 

orderfile2.doc 

Additional Information. 
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Select “Submit Form” 
when prepared 
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Review the summary 

If the summary is 
accurate, select 
“Continue to File 

Upload” to upload the 
files associated with 

the submission 

Updated: January 2015 111 

If there are any 
ERRORS, select “Upload 

Another Submission 
Form” and send an 

email  to 
register@sos.texas.gov 
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Select “Browse” Select the 
identified 
associated file 
from your 
available 
computer files 

Select “Upload Document” 

Repeat the 
process as 
needed to 
attach all 

associated 
documents 

Select 
“Submission 
Complete” to 

finalize 
submission 

**Must upload documents with the submission 
form. You are not able to return and upload at a 

later time.** 
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Guidelines 
Formatting and Submitting 
Rule Review 
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Guidelines 
Formatting and Submitting 
Rule Review 
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Texas Register Liaison Training 

Submission forms and 
corresponding files need 
to be submitted and 
received by  
 
 Monday at noon 

Updated: January 2015 115 

We will notify you of 
holiday exceptions. 

 
Still unsure? Wishing to 
plan? 

Publication schedule 
can be found on the 
Liaison Center Home 

screen 
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 Rulemaking process begins with a proposed rule 
 

 The proposed rule will be published in the Texas 
Register 
 

 Thirty days from publication, the rule is eligible to 
be filed for adoption 
 

 Twenty days after the adoption is filed/received, the 
rule is eligible to become effective 
◦ Every four years from the effective date, the rule should 

be reviewed 
 

 If the proposed rule is not acted on within  
six months of the publication date, the rule dies and 
is auto-withdrawn by the Texas Register staff 

Full 
instructions of 
the rulemaking 
requirements 
and process 

may be viewed 
in Chapter 

2001 of the 
Texas 

Government 
Code 
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Step 1 
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Proposed 

• New 
• Amended 
• Repeal 

Step 2 
Adopted

OR 
Withdrawn 

• Without Changes • With Changes 

Step 3 
Proposed Rule 

Review 

Adopted Rule 
Review 
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Sun Mon 

oon deadline 

Tues Wed Thurs Fri Sat 

1 2 3 4 5 7 

8 9 10 11 12 13 14 

15 16 17 18 19 21 

22 23 24 25 26 27 28 

29 30 31 October 

Submit 6 
Proposal 

Proposal 
20 

Published 

Publication is generally two 
work weeks behind deadline. 

n
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Sun Mon Tues Wed Thurs Sat 

1 2 3 4 5 7 

8 9 10 11 12 13 14 

15 16 17 18 19 21 

22 23 24 25 26 27 28 

29 30 31 October 
Sun Mon Tues Wed Thurs Fri Sa

November 1 2 3 

5 6 7 8 9 10 1

12 13 14 15 16 17 1

21 22 23 24 2

26 27 28 29 30 

noon 
deadline 

Fri 

Submit 
Proposal 

6 

20 

Elig. 19 Adopt20 
Received 

 
Adopt 

noon 
deadline 

t 

4 

1 

8 

5 
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The Proposal 
is eligible to 
be filed for 
adoption 30 
days after 
publication 

date. 

Proposal 
Published 
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30

November 1 2 3 4

5 6 7 8 9 10

12 13 14 15 16 17 18

19 20 21 22 23 24 25

26 27 28 29

Elig. 
Adopt Adoption

Filed

11

Adoption in effect?

20 days, unless 
otherwise 

specified, after 
adoption is filed 
with the Texas 

Register.

December 1 2

3 4 5 6 7 8 9

10 11 12 13 14 15 16

17 18 19 20 21 22 23

24 25 26 27 28 29 30

Adoption 
in Effect

Published
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Sun Mon Tues Wed Thurs Fri Sat 

1 2 3 4 5 6 7 

8 9 10 11 12 13 14 

15 16 17 18 19 20 21 

22 23 24 25 26 27 28 

29 30 31 October 

Sun Mon Tues Wed Thurs Fri Sat 

1 2 3 4 5 6 7 

8 9 10 11 12 13 14 

15 16 17 18 19 21 

22 23 24 25 26 27 28 

29 30 31 April 

Submit 
Proposal 

Proposal 
Published 

noon 
deadline 

When does the 
proposal expire? 

 20 Auto 
Withdraw 

If the scheduled day for auto 
withdraw is a holiday; then 
the next business day is it 

auto withdrawn 

noon 
deadline 
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As a courtesy, the 
Texas Register staff 
currently notifies the 
publishing agency of 

the upcoming 
expiration date. 



Guidelines 
Formatting and Submitting 
Rule Review 
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 Formatting and Submitting 
o Overview 
o Emergency Rulemaking 
o Proposed Rulemaking 

• Repeal 
• New 
• Amended 

o Adopted Rulemaking 
o Withdrawn Rulemaking 
o Common Preamble 

Updated: January 2015 123 



Texas Register Liaison Training Updated: January 2015 124 

Rulemaking 
Documents 

 Insert a section symbol when appropriate, §  
 

 Emphasize text with italics or ALL CAPS 
◦ Continue the emphasis through the punctuation 

immediately following the emphasized text 
 

 Use any justification, font or line spacing 
 

 Indicate a rule document by typing <rule> between 
the preamble and rule text 

Please view “Formatting the Word document” to 
properly structure the submission document. 
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Rulemaking 
Documents 

 Utilize any automatic Word formatting 
◦ Includes: outline text styling, headings, numbered lists, bulleted lists, 

headers/footers, hidden text, etc. 
 

 Show emphasis using underline or strikethrough in the preamble 
text 
 

 Show emphasis using bold within the preamble or the rule text 
 

 Utilize hyperlinks within the file 
 

 Utilize *n to create multiple documents within one file 
 

 Include a space between a section symbol and rule number 
◦ Correct: §74.1, Incorrect: § 74.1 

Please view “Formatting the Word document” to 
properly structure the submission document. 
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Rulemaking 
Documents 

 Naming the file: 
◦ Under 15 characters 
◦ Numbers and words only 
 No special characters (periods, spaces, number symbols, dashes, etc.) 
 Examples: SEC101, TxRegSub15, AGOpinions, etc 

 
 Referencing graphics: 
◦ Cite the figure line at the end of the appropriate section 
 Example: “Figure: 1 TAC §91.37” 
 Identify the figure line in the upper left corner of the graphic document 

◦ Upload the graphics file as an additional document after the main 
Word document within the same submission form 

 
 Submitting the file 
◦ Upload at the time of submission 
◦ You are not able to upload the file at any other time 

Must be saved as a Word document: .doc or .docx 
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Proposed 
Rulemaking 
Documents 

 New language: underline text 
◦ If the entire rule is new, underline the number and the text 
◦ Example: §91.75. Introducing a new rule. 

 Old language: [bracket text] 
 

 Language change: new language before [old language] 
 

 Include a period and a space after the rule number and 
rule title 
◦ §91.76. Introducing a new concern. 

Please view “Formatting the Word document” to 
properly structure the submission document. 
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Adopted 
Rulemaking 
Documents 

 Create a clean, complete copy of the rule text 
◦ Include previously omitted (no change) language from the 

proposal 
◦ Remove all references to new or [old] language from the 

proposal 
◦ Submit clean rule text exactly as it should be entered in the 

Texas Administrative Code 
 

 Include a period and a space after the rule number 
and rule title 
◦ §91.76. Introducing a new concern. 

Please view “Formatting the Word document” to 
properly structure the submission document. 



Updated: January 2015 Texas Register Liaison Training 129 

Documents submitted should be created 
using the following format settings. 

This allows the Texas Register staff to process the document. 
If the document is not created using the format settings, the 

document will not go through the Texas Register software 
appropriately.   

• Setting the style format 
• Removing numbered and bulleted lists 
• Inserting bullets 
• Inserting section symbols 
• Utilizing paragraph viewer 
• Saving the file 

*The following instructions for Word are based on Word 
2010. If you have another version of Word, please seek 

assistance through Word help or your IT department.  
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From the “Home” tab in Word,  
• Under “Styles,”  
• Select “¶ Normal” 

This removes Headings, unusual 
spacing and additional 

formatting Texas Register 
software will not be able to 

read. 
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Word automatically creates numbered and bulleted lists 
based on previous formatting preferences. Texas Register 
software does not process these as numbers or bullets, but 
as images. It is necessary to manually input these in order for 
the Texas Register staff to process the document effectively.  

From the “File” tab 
in Word,  
• Select “Options” 

In the pop-up 
window,  
• Select 

“Proofing,”  
• Then select 

“AutoCorrect 
Options…” 



Updated: January 2015 Texas Register Liaison Training 132 

In the AutoCorrect pop-up 
window, 
 
Under the “AutoFormat” 
tab, 
 
Under “Apply” 
De-select the following 
options: 
• “Built-in Heading 

styles,”  
• “List styles,”  
• “Automatic bulleted 

lists”  
• “Other paragraph styles”  
 
Under “Replace” 
De-select  
• “‘Straight quotes’ with 

‘smart quotes’” 
 
Select “OK” in the 
AutoCorrect pop-up 
window 
 
Then select the 
“AutoFormat As You Type” 
tab 
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Under the “AutoFormat As 
You Type” tab, 
 
Under “Replace as you 
type,” de-select the 
following: 
• “‘Straight quotes’ with 

‘smart quotes’” 
 
Under “Apply as you type,” 
de-select the following 
options: 
• “Automatic bulleted 

lists”,  
• “Automatic numbered 

lists”, 
• “Border lines”,  
• “Tables” and 
• “Built-in Heading 

styles” 
 
Select “OK” in the 
AutoCorrect pop-up 
window. 
 
Select “OK” in the Word 
Options pop-up window. 
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Bulleted lists can still be used, when each bulleted is inserted 
using the symbol function within Word. 

From the “Insert” tab in Word,  
• Select “Symbol,” 
• Under “Subset:,” 
• Select “Latin-1 Supplement,” 
• Select “·”  

• Character code “00B7” 
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Section symbols should be used instead of the word “Section” 
when appropriate; example 1 TAC §91.75 

From the “Insert” tab in Word,  
• Select “Symbol,” 
• Under “Subset:,” 
• Select “Latin-1 Supplement,” 
• Select “§”  

• Character code “00A7” 
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The paragraph function in Word allows users to view any 
additional or hidden formatting within the document  

From the “Home” tab in Word,  
• Under “Paragraph” 
• Select “¶” 
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Saving the file as a Word document, if not saved in the 
correct format, the document will not be processed by the 
software. 

From the “File” tab in Word 
• Select “Save As” 
• Type the new file name 
• Under “Save as type:” select: 

• “Word 97-2003 Document (*.doc) OR 
• “Word Document (*.docx) 

Must be saved as a “Word Document (*.docx)” or “Word 97-2003 
Document (*.doc)”  
Do not type “.doc” or “.docx” in the file name – Word will add the .doc or .docx 

extension once the type of document is selected and saved  



Texas Register Liaison Training 

 Formatting and Submitting 
o Overview 
o Emergency Rulemaking 
o Proposed Rulemaking 

• Repeal 
• New 
• Amended 

o Adopted Rulemaking 
o Withdrawn Rulemaking 
o Common Preamble 
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 Emergency rules are TEMPORARY 
rules adopted without notice or 
hearing 
As a temporary rule, the maximum 
amount of time the rule may be in effect 
is 180 days and will not become part of 
the Texas Administrative Code 



The reasons 
for the 

adoption of an 
emergency 

rule must meet 
Texas 

Government 
Code, 

§2001.034 
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http://www.statutes.legis.state.tx.us/Docs/GV/htm/GV.2001.htm
http://www.statutes.legis.state.tx.us/Docs/GV/htm/GV.2001.htm
http://www.statutes.legis.state.tx.us/Docs/GV/htm/GV.2001.htm


Original Emergency Rule 
Filed 

Renew Emergency Rule 

Emergency Rule Expires 

Texas Register Liaison Training 

Please Remember… 
 
This is a TEMPORARY 

rule. It will Not 
become part of TAC. 
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 Statutorily Required (written as a narrative in the following order): 

Introduction –  
agency name; action; TAC section number; subject material 
statement; explanation of action 

Statutory Authority –  
 action statute, article/section, explanation of agency’s authority 

Reason for Emergency –  
statement explaining the reason behind the emergency 

Key Points –  
There is no bolding, underlining or 
strikethrough allowed in the preamble; 
 
Italics or ALL CAPS may be used for emphasis. 

Please remember… 

Distinguish between preamble and rule text –  
Insert <rule> between preamble and rule text to distinguish in 
programming 

Updated: January 2015 141 



The Texas Youth Commission (TYC) adopts on an emergency basis an amendment to §85.33, 
concerning Program Completion and Movement of Sentenced Offenders. Sentenced offenders have 
been grouped by offense for the purpose of establishing certain internal review procedures. To 
the group named "category 1 sentenced offenders," the offense aggravated sexual assault is being 
added and the offense aggravated assault is being removed.  
This amendment is adopted on an emergency basis to ensure that youth who may pose greater 
risk to the public receive the highest level of internal review prior to any decision concerning a 
sentenced offender's movement.  
The amendment is adopted on an emergency basis under the Human Resources Code, §61.081, 
concerning Release Under Supervision, which provides the Texas Youth Commission authority to 
release a youth under supervision, who is committed to the commission under a determinate 
sentence, and §61.084, concerning Termination of Control, which provides TYC authority to 
discharge sentenced offender youth from its custody.  
<rule> 
Rule Text 
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Uploading Associated Documents 

Texas Register Liaison Training 

**Must upload documents with submission form. 
You are not able to return and upload files at 

another time.** 
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Liaison Center 
Home Screen 

Select “Emergency 
Rulemaking Submission” 
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Enter the 
applicable 
information 
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Select “List” to 
chose the 
applicable 
chapter number 
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The Subchapter
“List” will reflec
the chosen 
chapter 
number; select 
the applicable 
subchapter 

  
t 

This will 
populate the 
Division “List;” 
Select the 
applicable 
division 
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Original Filing 

Maximum 
days in effect: 
 
120 days 

Filing Type 

Renewal Filing 

Input TexReg 
Cite & Issue 
Date 

Maximum 
days in effect: 
 
60 days 

Name of the 
file 

uploaded on 
the next 
screen 

Updated: January 2015 150 

Select “Submit 
Form” when 
complete 
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Review the summary 

If the summary is 
accurate, select 
“Continue to File 

Upload” to upload the 
files associated with 

the submission 

Updated: January 2015 151 

If there are any 
ERRORS, select “Upload 

Another Submission 
Form” and send an 

email to 
register@sos.texas.gov 
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Select “Browse” Select the 
identified 
associated file 
from your 
available 
computer files 

Select “Upload Document” 

Repeat the 
process as 
needed to 
attach all 

associated 
documents 

Select 
“Submission 
Complete” to 

finalize 
submission 

**Must upload documents with the submission 
form. You are not able to return and upload at a 

later time** 
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 Formatting and Submitting 
o Overview 
o Emergency Rulemaking 
o Proposed Rulemaking 

• Repeal 
• New 
• Amended 

o Adopted Rulemaking 
o Withdrawn Rulemaking 
o Common Preamble 
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 An agency must submit a proposed rule 
before having a rule codified in the Texas 
Administrative Code 
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 What action is being taken? 
 Repeal 
◦ Removing a currently active rule 

 New 
◦ The language or rule is new and 

does not currently exist 
 Amendment 
◦ Altering language within the rule 

text or rule title 



Texas Register Liaison Training 

 Statutorily Required (written as a narrative in the following order): 

Introduction –  
agency name; action; TAC section number; subject material 
statement; explanation of action. 

Fiscal Note –  
name and title of employee preparing/approving fiscal note; is there 
an affect on state/local government for the first FIVE-YEAR PERIOD? 

Public Benefit Cost Note –  
name and title of employee preparing/approving Public Benefit Cost; 
summary for EACH year of the first FIVE YEARS; will there be a cost to 
individuals/small businesses? 

Comments –  
name and public contact information for the individual designated to 
receive comments regarding the proposal. 
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 Statutorily Required (written as a narrative in the following order): 

Statutory Authority –  
Action statute; article/section of the proposed action; explanation of 
the agency’s authority. 

Cross Reference to Statutes –  
Statutes, articles or codes the proposal affects. 

Distinguish between preamble and rule text -  
Insert <rule> between preamble and rule text to distinguish in 
programming. 

Please remember… 
Key Points –  

There is no bolding, underlining or 
strikethrough allowed in the preamble; 
 
Italics or ALL CAPS may be used for emphasis. 
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The Texas Education Agency (TEA) proposes an amendment to §150.1003, concerning educator appraisal. 
The proposed amendment adds language to 19 TAC §150.1003(b) and (d) to clarify timelines related to 
the completion of the teacher self-report form and the teacher appraisal calendar. The need for these 
clarifications is based on feedback from principals' and teachers' evaluation of the initial year of 
implementation of the Professional Development and Appraisal System (PDAS). Feedback indicated that 
schedules for the completion of the PDAS orientation for teachers and the completion of the teacher self-
report by teachers were unclear.  
Felipe Alanis, Deputy Commissioner for Programs and Instruction, has determined that for the first five-
year period the amendment is in effect there will be no fiscal implications for state or local government as 
a result of enforcing or administering the amended section.  
Mr. Alanis and Criss Cloudt, Associate Commissioner for Policy Planning and Research, have determined 
that for each year of the first five years the amendment is in effect the public benefit anticipated as a result 
of enforcing the amended section will be enhancement of the professional practice of teachers, providing 
students with increased levels of teaching performance and resulting in increased levels of student 
achievement. There will not be an effect on small businesses. There is no anticipated economic cost to 
persons who are required to comply with the proposed amendment.  
Comments on the proposal may be submitted in writing to Criss Cloudt, Policy Planning and Research, 
1701 North Congress Avenue, Austin, Texas 78701, (512) 463-9701. Comments may also be submitted 
electronically to rules@tmail.tea.state.tx.us or faxed to (512) 475-3499.  
The amendment is proposed under the Texas Education Code, §§21.351 - 21.356, which authorizes the 
commissioner of education to adopt a recommended appraisal process and criteria on which to appraise 
the performance of teachers.  
The proposed amendment implements the Texas Education Code, §§21.351 - 21.356. 
<rule> 
Rule text 



 

Texas Register Liaison Training 

 Are there special instructions for submitting proposed 
rulemaking? 

o Repeals may not be combined in the same submission as 
new or amended rules 

o Repeals are always filed before or with new rules if they 
have the same rule number 

o New rules and amended rules may be combined in the 
same submission form 

 What if the version of rules I have are not the most 
current? 

 
o Download the current rules from 

the liaison center to use in your 
proposed rulemaking documents. 
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 In the rule file: only include the rule number and rule title for repeal. 

Proposed Repeal Rule Example 

Statutorily Required Preamble  
<rule> 
§5.311. Purpose. 
§5.312. Definitions. 
§5.313. Eligibility and Exemptions. 
§5.314. Administration. 
§5.315. Standards. 
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Proposed 
Rulemaking 
Documents 

 New language: underline text 
◦ If the entire rule is new, underline the number and the text 
◦ Example: §91.75. Introducing a new rule. 

 Old language: [bracket text] 
 

 Language change: new language before [old language] 
 

 Include a period and a space after the rule number and 
rule text 
◦ §91.76. Introducing a new concern. 

Format the Word document using Normal style 



Proposed New Rule Text Example 

Statutorily Required Preamble  
<rule> 
§31.8. One-Half Time.  
"One-half time" employment shall in no case exceed 92 clock 
hours in any calendar month. Determination of half-time will be 
made on a monthly basis using calendar months. Actual course 
instruction in state-supported colleges (including junior colleges), 
universities, and public schools shall not exceed during any month 
one-half the normal load for full-time employment at the same 
teaching level. (This would usually limit employment in instruction 
in colleges and universities to no more than two three-semester 
hour courses during any one semester of the long term, two two-
semester hour courses during a nine-week term, or one three-
semester hour course during a six-week term. 
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Proposed Amendment Key Points 

 May not change parts of words 
◦ Incorrect:  
◦ The C[c]ommission will not accept applications .... 

 
◦ Correct:  
◦ The Commission [commission] will not accept applications[application] ... 
 

 May not amend a rule number 
◦ Submit a repeal and a new rule; use the same rule language 

under a new rule number 
 

 Exclude sections not currently being amended from 
rule text submitted 
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Proposed Amendment Rule Text Example 

Statutorily Required Preamble 
<rule>  
§31.8. One-Half Time.  
"One-half time" employment shall in no case exceed 92 clock hours in any 
calendar month. Determination of half-time will be made on a monthly 
basis using calendar months. Actual course instruction in state-supported 
colleges (including junior colleges), universities, and public [high] schools 
shall not exceed during any month one-half the normal load for full-time 
employment at the same teaching level. (This would usually limit 
employment in instruction in colleges and universities to no more than two 
three-semester hour courses during any one semester of the long term, 
two two-semester hour courses during a nine-week term, or one three-
semester hour course during a six-week term. Employment in instruction 
in public [high] schools would usually be limited to no more than two 
courses during any one semester of the long term.) "One-half time" 
employment for bus drivers shall in no case exceed 12 days in any 
calendar month. Work by a bus driver for any part of a day shall count as a 
full day for purposes of this section.  
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Uploading Associated Documents 
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**Must upload documents with the submission 
form. You are not able to return and upload files 

at another time.** 
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Liaison Center 
Home Screen 

Select “Proposed 
Rulemaking Submission” 
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Enter the 
applicable 
information 
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Select “List” to 
chose the 
applicable 
chapter number 
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The Subchapter  
“List” will reflect 
the chosen 
chapter 
number; select 
the applicable 
subchapter 

This will 
populate the 
Division “List;” 
Select the 
applicable 
division 
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Name of the 
file to be 

uploaded on 
the next 
screen 
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Select “Submit 
Form” when 
complete 
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Review the summary 

If the summary is 
accurate, select 
“Continue to File 

Upload” to upload the 
files associated with 

the submission 
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If there are any 
ERRORS, select “Upload 

Another Submission 
Form” and send an 

email  to 
register@sos.texas.gov 
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Select “Browse” Select the 
identified 
associated file 
from your 
available 
computer files 

Select “Upload Document” 

Repeat the 
process as 
needed to 
attach all 

associated 
documents 

Select 
“Submission 
Complete” to 

finalize 
submission 

**Must upload documents now, you are not able to return 
and upload at a later time.** 
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 Formatting and Submitting 
o Overview 
o Emergency Rulemaking 
o Proposed Rulemaking 

• Repeal 
• New 
• Amended 

o Adopted Rulemaking 
o Withdrawn Rulemaking 
o Common Preamble 
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 Following a proposal…
 Agency has opted to move forward with the

proposal

◦ Repeal
 Removing a current rule from TAC

◦ New
 Creating a new rule in TAC

◦ or Amended
 Altering the rule text or rule title in TAC

 Include the preamble in file
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Sun Mon Tues Wed Thurs Fri Sat 

1 2 3 4 5 6 7 

8 9 10 11 12 13 14 

15 16 17 18 19 20 21 

22 23 24 25 26 27 28 

29 30 31 October 

Submit 
Proposal 

Proposal 
Published 

Texas Register Liaison Training 

Sun Mon Tues Wed Thurs Fri Sat 

November 1 2 3 4 

5 6 7 8 9 10 11 

12 13 14 15 16 17 18 

19 20 21 22 23 24 25 

26 27 28 29 30 

Elig. 
Adopt 

Eligible for 
Adoption? 

30 days after the 
proposal is 

published in the 
Texas Register, 

the rule is eligible 
to be filed for 

adoption. 
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30

November 1 2 3 4

5 6 7 8 9 10

12 13 14 15 16 17 18

19 20 21 22 23 24 25

26 27 28 29

Elig. 
Adopt Adoption

Filed

11

Adoption in effect?

20 days, unless 
otherwise 

specified, after 
adoption is filed 
with the Texas 

Register.

December 1 2

3 4 5 6 7 8 9

10 11 12 13 14 15 16

17 18 19 20 21 22 23

24 25 26 27 28 29 30

Adoption 
in Effect

Published
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 Statutorily Required (written as a narrative in the following order): 
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Introduction –  
agency name; action; TAC section number; concerning statement; 
adopted with OR without changes; proposed publication date; cite 

Justification for Rule Action –  
explanation for the rule action  
**may be copied from the Proposed Preamble Introduction.** 

How the Rule will function –  
what purpose does the adopted rule serve 

Summary of Comments –  
If comments were received regarding the proposal: 
summary of the comment; agency’s response; and if it affected the 

rule language 
If no comments were received regarding the proposal: 
statement indicating no comments were received 



Texas Register Liaison Training 

 Statutorily Required (written as a narrative in the following order): 

Statutory Authority –  
Action statute; article/section of the proposed action; explanation of 
the agency’s authority 
**may be copied from the Proposed Preamble Statutory Authority** 

Distinguish between preamble and rule text –  
Insert <rule> between preamble and rule text to distinguish in 
programming 

Please remember… 
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Key Points –  
There is no bolding, underlining or 
strikethrough allowed in the preamble; 
 
Italics or ALL CAPS may be used as emphasis. 
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The Texas Education Agency (TEA) adopts an amendment to §150.1003, concerning educator 
appraisal, without changes to the proposed text as published in the January 6, 2012, issue of the 
Texas Register (37 TexReg 675). The rule will not be republished.  
The section establishes requirements and procedures related to appraisal of teachers. Legislation 
enacted in 2005 required the commissioner of education to adopt a recommended appraisal 
process and criteria on which to appraise the performance of teachers.  
The amendment adds language to 19 TAC §150.1003(b) and (d) to clarify timelines for completing 
the teacher self-report form and the teacher appraisal calendar. These clarifications are needed 
based on feedback from principals' and teachers' evaluation of the initial year of implementation 
of the Professional Development and Appraisal System (PDAS). Feedback indicated that schedules 
for the completion of the PDAS orientation for teachers and the completion of the teacher self-
report by teachers were unclear.  
No comments were received regarding adoption of the amendment. 
The amendment is adopted under the Texas Education Code, §§21.351 - 21.356, which 
authorizes the commissioner of education to adopt a recommended appraisal process and criteria 
on which to appraise the performance of teachers.  
<rule> 
Rule Text 



Adopted Repeal Rule Example 

Statutorily Required Preamble 
<rule> 
§5.311. Purpose. 
§ 5.312. Definitions. 
§ 5.313. Eligibility and Exemptions. 
§ 5.314. Administration. 
§ 5.315. Standards. 
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Adopted 
Rulemaking 
Documents 

 Create a clean, complete copy of the rule text 
◦ Include previously omitted (no change) language in the 

proposed text 
◦ Provide only completed language—no new or [old] language 
◦ Provide rule text exactly as it should be entered in the 

Texas Administrative Code 
 

 Include a period and a space after the rule number 
and rule text 
◦ §91.76. Introducing a new concern. 

Format the Word document using Normal style 
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Create a clean 
copy of rule text 

 
Include any 
previously 
excluded 
sections.  

A rule is adopted as With 
or Without changes: 
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WITH  
Changes: 

 
ANY changes 

within the rule 
text from the 

proposal 

WITH OUT 
Changes: 

 
NO changes 

within the rule 
text from the 

proposal 



Adopted New Rule Text Example 

Statutorily Required Preamble  
<rule> 
§31.8. One-Half Time.  
"One-half time" employment shall in no case exceed 92 clock 
hours in any calendar month. Determination of half-time will be 
made on a monthly basis using calendar months. Actual course 
instruction in state-supported colleges (including junior colleges), 
universities, and public schools shall not exceed during any month 
one-half the normal load for full-time employment at the same 
teaching level. (This would usually limit employment in instruction 
in colleges and universities to no more than two three-semester 
hour courses during any one semester of the long term, two two-
semester hour courses during a nine-week term, or one three-
semester hour course during a six-week term. 
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Adopted Amendment Rule Text Example 

Statutorily Required Preamble 
<rule>  
§31.8. One-Half Time.  
"One-half time" employment shall in no case exceed 92 clock hours in any 
calendar month. Determination of half-time will be made on a monthly 
basis using calendar months. Actual course instruction in state-supported 
colleges (including junior colleges), universities, and public schools shall 
not exceed during any month one-half the normal load for full-time 
employment at the same teaching level. (This would usually limit 
employment in instruction in colleges and universities to no more than two 
three-semester hour courses during any one semester of the long term, 
two two-semester hour courses during a nine-week term, or one three-
semester hour course during a six-week term. Employment in instruction 
in public schools would usually be limited to no more than two courses 
during any one semester of the long term.) "One-half time" employment 
for bus drivers shall in no case exceed 12 days in any calendar month. 
Work by a bus driver for any part of a day shall count as a full day for 
purposes of this section.  
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Uploading Associated Documents 
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**Must upload documents with the submission 
form. You are not able to return and upload files 

at another time.** 



Texas Register Liaison Training 

Liaison Center 
Home Screen 

Select “Adopted 
Rulemaking Submission” 
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Enter the 
applicable 
information 
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Select “List” to 
chose the 
applicable 
chapter number 
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The Subchapter  
“List” will reflect 
the chosen 
chapter 
number; select 
the applicable 
subchapter 

This will 
populate the 
Division “List;” 
Select the 
applicable 
division 
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Identify if the rule text of the 
referenced section numbers are 
“without” or “with changes to the 
proposal” 

If multiple section 
numbers are 
referenced and only 
one section number 
has changes from 
the proposal, it is 
still considered “with 
changes to the 
proposal” 
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Name of the 
file to be 

uploaded on 
the next 
screen 
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Select “Submit
Form” when 
complete 
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Review the summary 

If the summary is 
accurate, select 
“Continue to File 

Upload” to upload the 
files associated with 

the submission 
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If there are any 
ERRORS, select “Upload 

Another Submission 
Form” and send an 

email  to 
register@sos.texas.gov 
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Select “Browse” Select the 
identified 
associated file 
from your 
available 
computer files 

Select “Upload Document” 

Repeat the 
process as 
needed to 
attach all 

associated 
documents 

Select 
“Submission 
Complete” to 

finalize 
submission 

**Must upload documents now, you are not able to return 
and upload at a later time** 
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Texas Register Liaison Training 

 Formatting and Submitting 
o Overview 
o Emergency Rulemaking 
o Proposed Rulemaking 

• Repeal 
• New 
• Amended 

o Adopted Rulemaking 
o Withdrawn Rulemaking 
o Common Preamble 
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 Following a proposal or 
emergency… 
 
◦ Cancel a proposed or emergency 

rulemaking 
 

◦ Auto withdrawn (Texas Register staff) 
 If a proposed rule is not acted on by 

the agency within 6 months 
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Uploading Associated Documents 
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If uploading an associated file… 

**Must upload documents with the submission 
form. You are not able to return and upload files 

at another time.** 



Texas Register Liaison Training 

Liaison Center 
Home Screen 

Select “Withdrawn 
Rulemaking Submission” 
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Enter the 
applicable 
information 

Updated: January 2015 205 



Texas Register Liaison Training 

Select “List” to 
chose the 
applicable 
chapter number 
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The Subchapter  
“List” will reflect 
the chosen 
chapter 
number; select 
the applicable 
subchapter 

This will 
populate the 
Division “List;” 
Select the 
applicable 
division 
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Select “Submit 
Form” when 
complete 

Name of the 
file to be 

uploaded on 
the next 
screen 
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Review the summary 

If the summary is 
accurate, select 
“Continue to File 

Upload” to upload the 
files associated with 

the submission 
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If there are any 
ERRORS, select “Upload 

Another Submission 
Form” and send an 

email  to 
register@sos.texas.gov 
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Not necessary 
to submit an 
explanation 
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 Formatting and Submitting 
o Overview 
o Emergency Rulemaking 
o Proposed Rulemaking 

• Repeal 
• New 
• Amended 

o Adopted Rulemaking 
o Withdrawn Rulemaking 
o Common Preamble 
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Preamble which addresses multiple rules crossing subchapters and/or 
divisions within the same chapter. It may address both repeal & 

amended/new rules 
 

A common preamble must include the statutorily required information in a 
normal preamble 

‣ Proposed Common Preamble  
o The fiscal note, public benefit cost note and explanation of rule action may be 

addressed together 
 

‣ Adopted Common Preamble  
o The concerning statement and purpose of the adopted rule may be addressed together 

 
‣ Emergency Common Preamble  

o The subject material statement, explanation of action and reason behind the 
emergency rule may be addressed together 

 
The statutory authority should be addressed for each 

rule submission 
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Key Points 

 Common Preamble file should be 
included with the lowest rule 
number 
 

 If submitting a repeal and a new 
rule submission (with the same 
section number), submit the 
common preamble with the 
repeal 
 

 Each rule submission includes 
statutory authority before rule 
text 
 

 May use *n for multiple rule 
texts within one document 
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Order of file submitted 

Common Preamble 
 

Statutory authority 1 
<rule> 

Rule Text 1 
(lowest rule number) 

*n 
 

Statutory authority 2 
<rule> 

Rule Text 2 
*n 
 

Statutory authority 3 
<rule> 

Rule Text 3 
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 Deadline 
 General Information 

o Proposed Rule Review 
• Let the public know the agency 

is reviewing the rule 
o Adopted Rule Review 

• Let the public know the decision 
the agency has come to 
regarding the status of the rule 

 Submitting Rule Review 
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 Deadline 
 General Information 

o Proposed Rule Review 
• Let the public know the agency is 

reviewing the rule 
o Adopted Rule Review 

• Let the public know the decision the 
agency has come to regarding the 
status of the rule 

 Submitting Rule Review 
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Submission forms and 
corresponding files need 
to be submitted and 
received by  
 
 Wednesday at noon 
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We will notify you of 
holiday exceptions. 

 
Still unsure? Wishing to 
plan? 

Publication schedule 
can be found on the 
Liaison Center Home 

screen 
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 Deadline 
 General Information 

o Proposed Rule Review 
• Let the public know the agency 

is reviewing the rule 
o Adopted Rule Review 

• Let the public know the decision 
the agency has come to 
regarding the status of the rule 

 Submitting Rule Review 
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By Texas Government Code, §2001.039, 
agencies are required to review rules by 
the fourth anniversary of the effective 

date of the rules. 
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File 
Proposed 

Rule Review 

Inform the 
public of the 
intention to 
review the 

rule in 
question to 
identify if 

the reasons 
for adopting 
these rules 
continue to 

exist. 

Public 
Comment 

Period 

Allow for 
public 

comment to 
determine if 
it is felt the 

rule still 
applies. 

(Requires 30 
days from 
publication 

date) 

Adopted Rule Review 

Inform the public of the agency’s findings 
regarding the review and; Inform the public of any 
public comments received with responses to those 

comments. 

READOPTION 

The original 
reasons for 

adoption continue 
to exist 

REPEAL 

The original 
reasons for 

adoption do not 
exist 

READOPTION 
WITH 

CHANGES 

(through the 
rulemaking 

process) 

The original reasons 
for adoption do 

exist, but something 
about the rule needs 

to reflect other 
changes 
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 Required (written as a narrative in the following order): 

Proposed Rule Review –  
statement of explanation; language should reflect the intent of the 
rule review  

Updated: January 2015 220 

Introduction –  
agency name; identify the chapter to be reviewed 

Public Comments –  
 identify agency and/or employee to received public comments; 

include multiple forms of contact and deadline 

Please remember…

Key Points –  
There is no bolding, underlining or 

 strikethrough allowed in the rule review; 
 
Italics or ALL CAPS may be used for emphasis. 



Ex ample 
The Texas Workforce Commission (Commission) files this notice of its intent to review Chapter 807, 

concerning Career Schools and Colleges, in accordance with Texas Government Code §2001.039.  

An assessment will be made by the Commission as to whether the reasons for adopting or 

readopting the chapter continue to exist. Each rule will be reviewed to determine whether it is 

obsolete, whether the rule reflects current legal and policy considerations, and whether the rule 

reflects current procedures of the Commission.  

Comments on the review may be submitted to TWC Policy Comments, Workforce Policy and Service 

Delivery, attention: Workforce Editing, 101 East 15th Street, Room 440T, Austin, Texas 78778; 

faxed to (512) 475-3577; or e-mailed to TWCPolicyComments@twc.state.tx.us. The Commission 

must receive comments postmarked no later than 30 days from the date this notice is published in 

the Texas Register.  
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 Required (written as a narrative in the following order): 
Introduction –  

agency name; chapter reviewed; publication date and cite of the 
proposed rule review 

Summary of Comments –  
If comments were received regarding the proposal: 
summary of the comments and the agency’s response 

If no comments were received regarding the proposal: 
statement indicating no comments were received 
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Conclusion –  
 Agency authority to make the decision; identify if the decision is to 

readopt, readopt with changes or repeal the rule reviewed 
If readopted with changes or repealing the rule; when the public 

should expect the rule to begin the rulemaking process  

Please remember… 

Key Points –  
There is no bolding, underlining or strikethrough allowed in the rule review; 
 
Italics or ALL CAPS may be used for emphasis. 



Example  

The Texas Workforce Commission (Commission) adopts the review of Chapter 807, 

concerning Career Schools and Colleges, in accordance with Texas Government Code 

§2001.039. The proposed notice of intent to review rules was published in the October 25, 

2013, issue of the Texas Register (38 TexReg 7479).  

No comments were received on the proposed rule review.  

The Commission has assessed whether the reasons for adopting or readopting the rules 

continue to exist. The Commission finds that the rules in Chapter 807 are needed, reflect 

current legal and policy considerations, and reflect current procedures of the Commission. 

The reasons for initially adopting the rules continue to exist. The Commission, therefore, 

readopts Chapter 807.  
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 Deadline 
 General Information 

o Proposed Rule Review 
• Let the public know the agency is 

reviewing the rule 
o Adopted Rule Review 

• Let the public know the decision the 
agency has come to regarding the 
status of the rule 

 Submitting Rule Review 
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Uploading Associated Documents 
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**Must upload documents with the submission 
form. You are not able to return and upload files 

at another time.** 



Texas Register Liaison Training 

Liaison Center 
Home Screen 

Select “Agency Rule 
Review Submission” 
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Enter the 
applicable 
information 

Updated: January 2015 228 



Texas Register Liaison Training 

Identify if the 
Rule Review is 
“Proposed” or 
“Adopted” 
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Enter the 
applicable 
information 

Name of the 
file to be 

uploaded on 
the next 
screen 

Select “Submit 
Form” when 
complete 
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Review the summary 

If the summary is 
accurate, select 
“Continue to File 

Upload” to upload the 
files associated with 

the submission 
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If there are any 
ERRORS, select “Upload 

Another Submission 
Form” and send an 

email  to 
register@sos.texas.gov 
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Examples 
 

Tables 
Equations 

Images 

File submitted separate 
from the .doc/.docx 

Adobe Acrobat (.pdf) 
Word (.doc/.docx) 

Miscellaneous 
 

Published with the 
document in the 

“In Addition” 
section of the 
Texas Register 

Rulemaking 
 

Published in the 
“Tables and 

Graphics” section 
of the Texas 

Register 



Rulemaking Documents 

 Insert a “Figure Line” in 
place of the graphic in the 
text of the rule 
◦ “Figure: 1 TAC §91.37” 

 
 The Figure Line should be 

labeled on the upper left 
corner of the document 

 
 .pdf, .doc, .docx files only 
◦ Example: “rule1graphic.pdf” 

Texas Register Liaison Training 

Miscellaneous Documents  

 Insert the word “Figure” in 
place of the graphic in the 
document 

 
 Multiple graphics: 
◦ “Figure 1” 
◦ “Figure 2” 
 

 The Figure number should 
be labeled on the upper left 
corner of the document 

 
 .pdf, .doc, .docx files only 
◦ Example: “misc1graphic.pdf” 

File submitted 
separate from the rule 

or miscellaneous 
document 

Adobe Acrobat (.pdf) 
Word (.doc/.docx) 
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Liaison Center 
Home Screen 

Select “My Submissions” 

The queue includes 
documents submitted 
within the last six 
months 
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Once the Texas Register 
staff has accepted a 
submission, the Liaison 
will receive an 
Acknowledgment of 
Receipt via email 
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